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1. Introduction

WordRef is an application which allows users of Microsoft Word to define and 
refer  to  cross-references  and to  have citations  and bibliographies  automatically 
generated.  This is accomplished via the Print Merge facility of Microsoft Word: 
the cross-references and citations are print merge variables (enclosed in « and ») 
which the WordRef application scans and provides values to.

WordRef is being distributed under the Shareware system.  If you find it useful, 
the price is $25, which should be sent to:

Mark Nodine
70 Mountain Avenue
Riverside, RI  02915-5016

Permission  is  granted  to  copy  and  distribute  WordRef,  provided  that  the 
complete  package  (application,  stack,  desk  accessory,  and  document)  is  kept 
together,  and  that  the  package  not  be  sold  commercially  for  more  than  the 
reasonable cost for the distribution medium.

Bug reports  or  suggestions  can be  mailed  to  the  above address  or  sent  via 
electronic mail to “man@cs.brown.edu”.

Many thanks are due to Herb Barad who developed the stack on which the 
WordRef stack was based and kindly gave permission to use it as my starting point. 
Thanks  are  also  due  to  Sven  Axelsson  who  substantially  reworked  the  user 
interface of the WordRef stack during testing.

1.1. WordRef features

There have been at least two earlier applications released which use the Print 
Merge facility of Microsoft Word for similar purposes.  I have opted to write my 
own because neither one of these (Scholar’s Aid and Xref) were general enough to 
suit my needs.  I have tried to make this application as flexible as possible so that it  
can  accommodate  virtually  any  bibliographic  style  or  cross-referencing  needs. 
Some of the features of WordRef are
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• No limit on the number of counters (variables) used for cross-references.

• Variables can be combined in general arithmetic expressions.

• Increment operators are included for convenience.

• Variables can have strings interspersed with numbers.

• Can scan Word files directly (if Fast Save is off).

• There can be any number of Word files or bibliography files in a single 
manuscript.

• The bibliography files are kept in the ever popular BibTEX format.

• A HyperCard stack is provided for maintaining the bibliography files.

• An  additional  field  is  provided  for  each  card  for  free-form  comments, 
keywords, etc.

• Several different citation styles are provided to go at the point of reference.

• A user-definable style sheet is used for formatting the bibliography entries.

If you have used an earlier version of WordRef, you will be interested in section 
7 of this document which is entitled “Release Notes”.

1.2. Compatibility information

WordRef 1.4 is fully compatible with System 6 and 7, with Microsoft Word 3, 
4, or 5, and with any version of HyperCard 2.0 or later.

2. The WordRef Application

The WordRef application is what scans all the Word files looking for references 
and citations, scans the bibliographic databases if necessary, and then outputs the 
files  which  will  be  used  by  Word’s  Print  Merge  facility  to  generate  the  final 
document.

First, a word about nomenclature.  A cross-reference is a tag used to name a 
figure or other part of a document; there are two parts to it: the  definition which 
gives a value to the tag and possibly many references which use the value assigned 
to the tag.   Citations are the tags which occur at  the point  in the file  where a 
bibliographic  reference  is  cited.   The  bibliographic  references (or  simply 
references,  if  the  context  is  clear)  are  the  items  which  occur  en  masse in  the 
bibliography.  

2.1. Manuscripts

A “manuscript” is a WordRef document.  It is a collection of possibly many 
Word documents (but not more than around 32,000 of them…) and possibly many 
BibTEX text files (same limitation) along with several miscellaneous files and a 
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specification of the options to be used in generating the bibliographies.  A typical 
manuscript file appears below.

2.1.1. Word files and bibliography files

The Word files are shown in a scrolling list toward the top left of the manuscript 
window and the bibliography files in a similar list toward the top right.  Hitting the 
“Add…” button under either of this lists will add new files to the corresponding 
list.   Shortcut:  if  you hold down the command key while  hitting the “Add…” 
button,  you will  continue to  be  prompted for  files  until  you cancel  out  of  the 
dialog.  If the file is in the same directory as the manuscript file, the short name 
appears (this goes for all the file names in the manuscript); otherwise the fully 
qualified name appears.  If the fully qualified name is too long to fit in the given 
space, it will be abbreviated in such a way as to show as much of the context as 
possible.

Files can be removed from the Word or bibliography lists by selecting them and 
choosing the corresponding “Remove” button.  The files can also be rearranged by 
selecting a file and hitting either the “Up” or “Down” buttons.  The order in which 
the references and citations are processed in the Word file is important, so if there 
are multiple files, make sure they appear in the order you intend to have them in  
the  final  document.   Right  now,  the  order  of  the  bibliography  files  is  only 
important if the same key appears in more than one file (the first one will be used 
and a warning will be issued).
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2.1.2. Miscellaneous files

The  files  which  are  above  the  solid  black  line  (including  the  Word  and 
bibliography files) are input files; those below the black line are output files.  The 
files  are  specified  by  clicking  in  the  dotted  rectangle  to  the  right  of  the 
corresponding label.  This causes a dialog box to pop up prompting for the name of 
the file.  An incorrect file name can be either replaced by clicking again in the 
dotted rectangle, or deleted by holding the command key down while clicking in 
the dotted rectangle.

Bibliography  style:   This  is  a  Word  file  which  specifies,  for  each  type  of 
reference, how the fields should be formatted.  See section 3.1 for a description of 
the types of references and section 5.3 for information about the format of this file. 
This must be specified if “Output Bibliography” or “Output Everything” is selected 
in the “Options” menu.

References include file:  All the cross-references and citations will be put into 
this file as «SET» directives for Word’s Print Merge facility.  This file should be 
included  at  the  top  of  each  Word  file  in  the  manuscript  using  the  syntax 
“«INCLUDE file-name»”, where file-name is the name of the file.  This should be 
the first thing in the file unless you are also including a bibliography in this file, in 
which case it should be the second thing (keep reading).

Bibliography data file:  This data file collects all the information needed for 
generating a bibliography.  If the manuscript contains several files, this file should 
be included in only the file in which the actual bibliography will occur.  It should 
be named as the very first thing in that file using the syntax “«DATA file-name»”, 
where file-name is the name of the data file.

Bibliography include file:  This file is included in the actual location within the 
file where the bibliography is to appear.  It should be included at that point with the 
syntax “«INCLUDE file-name»”, where file-name is the name of the file.

2.1.3. Citation options

The  citation  options  control  how  the  citation  tags  will  be  generated.   The 
citation options window appears below.
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“Omit Citations in Text” simply defines each of the citations to be the null 
string.  The references are collected normally and the rest of the citation options 
will be applied to the key which finally appears in the bibliography.  For example, 
if “Omit Citations in Text” is selected along with “Use Numbers Starting From:” 
with a value of 1, the final bibliography will use numbers starting from 1 for the 
keys.  This option is useful if you have a general bibliography and don’t want to 
bother quoting things specifically.

“Use Numbers Starting From:” and the number which follow it mean that the 
citations will be numeric.  The numbers will be incremented according to the order 
in which the articles are cited (two citations to the same article will receive the 
same number)  if  “Citation  Order”  is  chosen for  the  “Number  in”  option;   the 
alternative is to sort the bibliography alphabetically by author and then assign the 
numbers.  In either event, the bibliography will be sorted according to the citation 
numbers.

“Use Labels” means that the citation style will be some alphanumeric label, 
which will also be used for sorting the bibliography.  There are two ways that this  
alphanumeric label can be generated.  “From Key Field” will use the key field 
exactly as it is specified in the citation (and hopefully found in the bibliographic 
data base).  “From Main Author & Year” will generate a key based on the last 
name of the main author and the year, if it occurs.  See section 3.2 for a definition 
of  what  exactly  constitutes  a  last  name.   “Letters  of  Author’s  Name” lets  you 
specify how many letters of the author’s name will be used to generate the key and 
“Digits  of  Year”  specifies  the  last  how many  digits  of  the  year  will  be  used 
(reasonable values are 2 and 4).  The template allows the format of the citation to  
be customized considerably.  Where an “a” or “A” appears in the template, the 
author’s name is substituted for it (forced to all upper-case for “A”).  The year gets 
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substituted in for a “y”.  Finally, a “tiebreaker” will be substituted in for a “t” or a 
“T”, if there should be more than one reference by the same author in the same 
year.  For example, an article by Thomas van Vleck published in 1980 would be 
specified by “Vlec80” if “Letters of Author’s Name” is 4, “Digits of Year” is 2, and 
template is “ayt”.  It would be “VLEC80” if the template were “AyT”.

The “Bibliography…” button puts up the window for setting the bibliography 
options (see below).  If you subsequently cancel out of the bibliography options 
window, any changes you have made here will also be canceled.

It should be pointed out that in some cases, special steps need to be taken if no  
author is  present  in a given reference.   If  the “Number in Alphabetical  Order” 
option is chosen with numeric citations, or a tag is generated using the author, this  
situation may come up.  If there is no author present, then the first name in the  
“Editor” field will be used.  If there is no editor present either (this should only 
happen with type “Manual”),  then the first  word in the “Organization” field is 
used.

2.1.4. Bibliography options

The bibliography options specify how the bibliography entries will appear.  The 
bibliography options window appears below.

So far, all the bibliography options concern how the authors will appear in the 
bibliography.  “Reverse Several  Authors’ Names:” and the number following it 
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mean that the first that many authors will have their names appear as Last Name, 
First Names.  Putting in a 99 will ensure that all the authors will have their names 
reversed (the most authors I ever saw on a single paper was 54, on a high-energy 
physics article which apparently took 50 people to run the accelerator and 4 to do 
the thinking, but that’s another story).  “Insert Conjunction Before Last Author” 
controls (surprise) whether a conjunction is inserted before the last author.  The 
specific conjunction can be specified in case you’re writing for a French journal or 
something.   If  there is  a  conjunction to be put  in,  you have your option as to 
whether the punctuation will appear before it never, always, or only if there are 
more than two authors.  If “Use Authors’ Initials” is selected, then full names will  
be  abbreviated  to  initials.   Because  of  this  option,  the  bibliographic  database 
should  contain  full  names  wherever  possible,  to  allow  as  much  flexibility  as 
possible.  The initials are not separated by a space, i.e., they will be “P.T. Barnum” 
rather  than  “P.  T.  Barnum”.   The  punctuation  between  authors  can  also  be 
specified.   The  punctuation  will  be  used  to  separate  any  authors  without 
conjunctions between them and sometimes before the conjunction (see above).  To 
aid  understanding  of  the  various  parameters,  the  author  parts  of  two  example 
references appear formatted in the window according to the current set of options. 
The names cover the gamut of what might appear: a “van”, a compound last name 
“Vander Zanden”, and a “Jr.” and a “III”.

2.2. Cross-references (simplified)

One of the main purposes for which WordRef was written is to allow symbolic 
cross-referencing within a file or set of files.  This allows you, for example, to 
define “projected_GNP” to have a number in one place in the file and then to 
simply refer to “projected_GNP” elsewhere in the file.  While this is not so wildly 
useful  in and of itself,  when combined with the ability to define variables and 
perform arithmetic, this provides a very general mechanism for doing things like 
numbering your figures and equations automatically and having all the references 
change appropriately if you insert a new figure in the middle.

2.2.1. Variables

A WordRef variable is any string of characters beginning with an alphabetic 
character  (a-z,  A-Z)  or  underscore  (_)  followed  by  any  number  of  alphabetic, 
numeric (0-9), or underscore characters.  (If you think this looks a lot like a valid C 
symbol,  you’re  right!)   The  variable  can  contain  either  numbers  or  text  or 
combinations of the two.  Variables are defined in definitions and can appear in 
either references or expressions.

2.2.2. Definitions

A definition defines a WordRef variable.  A definition is of the form

«#variable:expression»

where the German open and close quotes (« and  », respectively) signify a Word 
Print Merge variable, the “#” is the flag to WordRef that it should process this Print 
Merge  variable,  “:”  is  the  assignment  operator,  and  expression is  an 
expression which specifies what value the variable should take on.  The complete 
syntax for expressions is given in section 4.1; here I present only the two operators 
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which will get 90% of the work.

Incidentally, the reason that “:” is used as the assignment operator is that a 
Word Print Merge variable can apparently consist of any characters except  “=” or 
“»”, the former of which is the likely assignment operator.

The simplest expression simply sets the variable to a constant, for example,

«#figure:1»
«#ratio:"around 23"»

Here  you  can  see  that  constants  are  either  numbers  or  strings  enclosed  in 
(unsexed) double quotes (").  The two most useful operators are concatenation (&) 
and pre-incrementation (++var).  

Concatenation glues two things together, one right after the other. 

Pre-incrementation causes the variable to be incremented by one and uses the 
new value.  If the variable contains a number (sequence of digits 0-9), this is an 
obvious operation.  If the variable does not contain any numbers, then this is an 
error.  If the variable contains more than one number with intervening characters 
(e.g., “(1.2)”), the last number in the sequence will be incremented (in this case, 
to “(1.3)”).  If the variable has never before been defined, it is assumed the value 
is zero.

Examples of these appear below, along with what the final value of the symbol 
will be.

«#chapter:1» 1
«#section:chapter&"."&1» 1.1

«#table:0» 0
«#projected_GNP:++table» 1

«#projected_deficit:++table» 2
«#next_section:++section» 1.2
«#deficit_vs_GNP:++figure» 1

2.2.3. References

A reference has a similar format to a definition:

«#variable»

Note the lack of a “:” in the Print Merge variable.  The variable must be defined 
exactly once in the suite of Word files contained in the manuscript.  The reference 
may precede  the  definition,  and,  in  fact,  may  be  in  a  different  file  from  the 
definition.   If  the variable is  not  defined,  or if  it  is  defined more than once,  a 
diagnostic message is given by WordRef.
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2.2.4. Silent references and other caveats

Though the syntax of the “#” Print Merge variables may look disarmingly like a 
programming language, there are some subtle but important differences.

• The definitions are processed in the order they occur in the file, after which 
the values are assigned to the references.  Thus, references can precede the places 
where they are defined.

• Variables used in references must be defined exactly once.

• Variables which are have not been defined before being used in expressions 
are assumed to be zero (0).

• Since each of the definitions is, itself, a Print Merge variable, this means that 
each symbol must have a single value.  For example, if you have something like

«#chapter:1»«#first:chapter»

• • •

«#chapter:chapter+1»«#second:chapter»

• • •

«#chapter:chapter+1»«#third:chapter»

you  have  a  definite  problem  since  the  Print  Merge  symbol 
«#chapter:chapter+1» needs to take on the values 2 and 3 (not to mention 
that  each  of  your  numbers  will  be  duplicated  — once  for  the  definition  of 
chapter and once for the definition of the specific name for that chapter — if 
this were the only problem, it could be fixed by using hidden text).  To get around 
this problem, WordRef allows “silent” definitions.   If  any Print Merge variable 
begins with not one, but (count them!) two #’s, the Print Merge variable becomes 
the null string.  Thus, if the above example were instead written

«##chapter:1»«#first:chapter»

• • •

«##chapter:chapter+1»«#second:chapter»

• • •

«##chapter:chapter+1»«#third:chapter»

then the desired effect could be achieved.  Silent definitions are also useful for 
initializing things that change at the top of every chapter, for example:

Chapter «#GNP:+
+chap»«##fig:chap&".0"»«##eq:"("&chap&"-0)"» ...

Then, assuming GNP = 5, putting «#GNP1988:++fig» will result in the string 
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“5.1” and «#GNPvsUnemployment:++eq» will result in “(5-1)”.

2.3. Citations

Citations are very simple; they have the format

«@key»,

where  key is  the  key  given  to  the  bibliographic  entry  in  the  bibliographic 
database.  The “@” is the tag which tells WordRef that this Print Merge variable is 
intended to be a citation.  You will not be successful if the key contains spaces or 
commas.

2.4. Application menus

The  items  in  the  File  menu  work  just  as  they  do  in  any  other  Macintosh 
application you have used with  two exceptions:  (1)  a  Close  will  automatically 
initiate another Open (you can cancel out of it to stay in a state where you have no 
manuscripts open, but this doesn’t seem very useful; you can also choose New to 
create a new manuscript), and (2) there is an item called “Compile References…” 
which actually parses all the Word files and, if necessary, scans the bibliographic 
databases.

The Edit menu is entirely unused by the application; indeed there is nothing to 
cut or paste that is not in a dialog box.  The menu is provided for the convenience 
of desk accessories.

The first three items in the Options menu determine what kind of Print Merge 
variables WordRef will process in parsing the Word files (and what miscellaneous 
files it requires you to have given values to before doing a Compile References…). 

The  “Verbose”  option  in  the  Options  menu  forces  extra  output  to  make 
debugging your manuscript easier.

The  final  two  items  in  the  Options  menu  have  been  described  in  detail  in 
sections 2.1.3 and 2.1.4.

3. The WordRef Stack

The WordRef stack is used to update BibTEX bibliographic databases and to 
convert imported databases to the format that the WordRef application uses (more 
about  this  in  section  5.2).   It  keeps  a  separate  card  for  each  reference  in  the 
database, as if you had a box of index cards.  The cards are organized into 13 
different  reference  types,  according  to  what  fields  are  required  to  be,  or  may 
optionally be present.  This stack requires HyperCard version 1.2.2 or later.  It also 
requires the font Helvetica 10 in the System file.

3.1. BibTEX reference types

The following table details,  for  each of  the reference types,  what  fields are 
required and what fields are optional.  In all cases, the key field (the one which 
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appears after the “@” in a citation) is a required field, so it is left out of the table. 
(Note:  key  fields  should  not  contain  spaces  or  commas.)   In  addition,  each 
reference type allows an optional “comments” field which is also left out of the 
table.

Reference Type

Required Fields

Optional Fields

article

author 
title 
journal 
year 

volume
number
pages
month
note

book

title 
publisher 

year 

author 
editor
volume
series
address
edition
number
month
note

booklet

title 

author
howpublished

address
year
month
note
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inbook

title 
publisher 

year 

author 
editor
volume
series
number
edition
type

address
chapter 
pages 
month
note

incollection

author 
title 

booktitle 
year 

publisher 

editor
volume
number
chapter
pages
series
edition
type

address
month
note
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inproceedings

author 
title 

booktitle 
year 

organization
publisher
volume
number
pages
address
editor
series
month
note

manual

title 

author
organization

address
year

edition
month
note

mastersthesis

author 
title 
school 
year 

address
month
type
note

misc

title
author

howpublished
year
month
note
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phdthesis

author 
title 
school 
year 

address
month
type
note

proceedings

title 
year 

editor
publisher

organization
month
address
volume
number
series
note

techreport

title 
author 

institution 
year 

type
number
month
address
note

unpublished

author 
title 
note 

year
month

3.2. Author and editor fields

The  author and  editor fields are a little  different  from the rest,  in that 
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WordRef actually has to parse them in order to put them in the right format.  Any 
other BibTEX processor will have to do the same.  To allow this reformatting to 
take place, the names in the  author field (anything that holds for the  author 
field holds for the editor field, as well) must conform to certain rigid formats. 
Multiple authors are separated by the word “and”.  So, if you have three authors, A, 
B, and C, the author field should read “A and B and C”.  The individual names 
are divided into four parts, called  first,  last,  von,  and  jr.   The last two may be 
blank.  The valid formats are

First von Last
von Last, First

von Last, Jr, First

A von is recognized because it begins with a lower case letter.  There can be more 
than  one  word  in  any  part  except  the  Jr,  for  example,  “Joseph  Martin  de  la 
Ground Round, Jr.”  Here we have

First = Joseph Martin
von = de la

Last = Ground Round
Jr = Jr.

Thus, for example, a multiple word last name could not be entered in format 1 
unless there is a von part, because otherwise it would be impossible to separate the 
first word of Last from the last word of First.  If there is a Jr, format 3 must 
be used.

Since the names are parsed and can be formatted in different ways, it is advised 
that  you  enter  the  full  first  names  into  the  bibliographic  database  wherever 
possible.  If the particular format calls for using the authors’ initials, they can be 
automatically generated.  On the other hand, if the format calls for the full first  
names and you have entered only initials into the database, you are out of luck.

3.3. What each button does

Goes to the home stack.

This  button puts  up a pop-up menu used to add 
new references  to  the  bibliography and to  move 
through the references by type.  Picking any of the 
menu items will add a new card of the given type. 
If either the shift, the option, or command key (I 
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hate  having  to  remember  which  key  to  hold)  is 
held down while clicking on the button, the stack 
will go to the next card of that type.

Sorts the stack by key.  All the blank cards will 
wind up at the beginning of the stack.

Fast-flips through all the cards in the stack.

(Head card only.)   Puts up a set of instructions for 
the stack.  Click anywhere in the window except 
the scroll bar to make it go away.

(Head card only.)  Initiates a search.  You can type 
several words for which to search.  Hitting return 
actually begins the search.  A card will be matched 
only if all the words in the search string are found 
somewhere on the card.  The words do not have to 
match complete words, and the matching is case-
insensitive.  The words do not have to be found in 
the  same  card  field.   For  example,  “find  "dick 
herma"”  would  match  a  card  which  contained 
“Moby  Dick”  in  the  “title”  field  and  “Herman 
Melville” in the “author” field.  Hitting the enter 
key after a successful search will initiate another 
search from the current location.  Occasionally a 
successful search will  terminate without any text 
highlighted.   When this occurs,  it  is  because the 
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text  was  found  in  the  comments  field,  which  is 
automatically hidden every time a data card is left. 
Opening the comments field (see below) will allow 
you to find the matched text, although it will not 
be highlighted.

(Head card only.)  Opens the strings field.  Strings 
are of the form

abbrev = "full-name"
Whenever a field begins with a period (full-stop, 
“.”), WordRef knows to look for a string with the 
same name but without the period.  For example, if 
you  had  a  field  with  the  contents  “.abbrev”, 
then  WordRef  would  look  for  a  string  with  the 
name “abbrev” on the left side of an equal sign 
and substitute in the value found on the right side 
of the equal sign.  This is very useful if you submit 
papers  to  journals  with  different  styles.   For 
example,  some  journals  may  spell  out  month 
names completely, whereas others may abbreviate 
them.  In the month field of a particular card, you 
might  put  something  like  “.dec”,  and  then  by 
changing the strings field you could have it expand 
either as

dec = "Dec."
or as

dec = "December".
Likewise,  different  journals  may  abbreviate 
journals differently.

(Head card only.)  Goes to the first data card whose 
key is not blank (this may take a moment).  This is 
useful  for  skipping over  all  the  blank cards  that 
cluster near the beginning of a sorted stack.
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(Head card only.)  Reads in a file containing string 
definitions.  The file should previously have been 
written using the “Write Strings…” button.   The 
“Read  Strings…”  button  does  not  clear  the 
contents of the Strings field before reading.  Any 
strings from the file that are not already present in 
the field put at the end of the field;  strings which 
were  already  present  in  the  Strings  field  are 
replaced.  If you want the Strings field to match 
the contents of the file exactly,  you should clear 
out  the  field  first  by  hand  and  then  do  “Read 
Strings…”.

(Head card only.)  Writes out the contents of the 
Strings field into a file which can be read using the 
“Read Strings…” button.

(Head card only.)  Reads in a BibTEX text file.  If 
this  file  was  created  with  Word,  it  should  have 
been saved as “Text Only”.  You will be prompted 
for  the  name  of  the  file.   A new  card  will  be 
created in the stack for each reference in the file. 
Once all the references have been read in, the cards 
will automatically be sorted by key.

(Head  card  only.)  Saves  the  current  stack  as  a 
BibTEX text file.   You will  be prompted for the 
name  of  the  file  (a  reasonable  name  will  be 
suggested)  to  create.   You  will  also  be  asked 
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whether  to  save  for  WordRef  or  some  other 
BibTEX processor.  This is because other BibTEX 
processors  need  to  use  a  straight  ASCII  format 
with no Macintosh special characters.  A reference 
will be written for every card in the stack with a 
non-blank key.

(Head card only.) Searches the stack to see if there 
are any duplicate keys.  This has the side-effect of 
sorting  the  stack  by  key.   If  no  duplicates  are 
found, a message to that effect is displayed.  If any 
duplicates are found, their keys will be displayed 
in the message box.  If the list of duplicate keys 
extends off the right edge of the message box, the 
information can be retrieved by deleting text to the 
left  of  what  cannot  be  seen,  or  by  selecting  the 
entire contents of the message box, copying to the 
clipboard, and pasting into something that will let 
you see it all.

(Head  card  only.)  Creates  a  new  stack  that  is 
identical to the current stack (except for the name, 
of course).  You will be prompted for the name of 
the  new  stack.   WordRef  is  designed  to  handle 
multiple  bibliographies.   For  this  reason,  the 
suggested  mode  of  operation  is  to  leave  the 
original WordRef stack empty, and use this button 
to create a new bibliography stack every time you 
want a distinct set of references.

(Head card only.) Removes all the references from 
the stack.  You will be prompted to make sure this 
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is what you really wanted to do before proceeding. 
This is useful if you forgot to do “New Stack…” 
before doing a “Read BibTeX…”.

(Data  cards  only.)   Converts  a  card  from  one 
reference  style  to  another.   For  example,  if  you 
typed in a reference as an Article and later decide 
that  it  should  have  been  an  InProceedings,  this 
button  can  do  it  for  you.   When  you  push  the 
button, a menu will  pop up asking to what style 
you want to convert.  Simply choose the new style 
you  want,  and  the  conversion  will  take  place. 
Anything  you  typed  in  a  field  in  the  old  style 
which  does  not  exist  in  the  new  style  will  be 
automatically put into the “Other Fields” field.

(Data cards only.)  Goes to the head card of the 
stack.

(Data cards only.)  Opens up the Comments field. 
A window like the one below will appear.  You can 
put anything you want into this field (up to around 
32,000 characters).  Unlike the “notes” field, what 
you  put  here  will  not  appear  in  the  formatted 
bibliography.  You can use this to put keywords for 
searching or notes to yourself about the content of 
the  article.   Clicking  in  the  box  to  the  left  of 
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“Comments”  or  leaving  the  card  will  cause  the 
field to become hidden.  The icon has a shadowed 
box around it if the Comments field is empty and a 
plain box if the Comments field has text in it.

(Data  cards  only.)   Puts  up  a  scrolling  field  for 
putting extra fields which may be desired for other 
BibTeX systems.  It is suggested that you not use 
this  feature  if  you  are  only  going  to  use  the 
references with the WordRef application.  In any 
event,  the  fields  you  put  here  should  have  the 
format

<name> = {<contents>}
and should be separated by return characters (the 
lines may wrap without return characters, so do not 
be confused) without commas.  If you intend to use 
the  bibliography  file  with  WordRef,  you  should 
avoid putting double  quotes  (")  anywhere  in  the 
field.   You  can  work  around  this  by  using 
typographer’s quotes (“ and ”), if need be.

The button is surrounded by a shadowed box if the 
Other Fields field has no text in it;   a plain box 
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around  it  means  that  there  is  text  in  the  Other 
Fields field.

(Data  cards  only)   The dog-ears  at  the  top-right 
part  of the cards allow you to go to the next or 
previous card.  Clicking on the lower-left dog-ear 
goes to the next card; the upper-right goes to the 
previous card.

4. The WordRef Browser Desk Accessory

WordRef comes with a desk accessory (DA) to make it easier to find citations 
while writing your document in Microsoft Word.  See the Macintosh User’s Guide 
for instructions on installing DA’s.

The WordRef desk accessory will be able to open the bibliography files created 
by the WordRef stack (version 1.3 or later) using “Write BibTeX…” followed by 
pressing the “WordRef” button.  It puts up a scrolling list of all the keys in the file. 
You can select a key by clicking on it, and copy it to the clipboard using the Copy 
command.  You can also show the text of the reference either by double-clicking 
on the reference or by choosing “Show” from the browser’s menu.  Finally, you 
can open a new bibliography file by choosing “Open…” from the browser’s menu.

5. Putting it All Together

The general procedure for using WordRef to put together a paper is as follows. 
First use the WordRef stack to enter the bibliographic references you may use in 
the paper.  Then choose the “Write BibTeX…” button in the stack to create a text-
only BibTEX file which will be used by the WordRef application.

Then write the paper (this is sometimes the hard part…).  This doesn’t have to 
be done strictly after the previous step; the only important thing is that the text-
only BibTEX file contain all the references you are going to cite.  You can put in 
cross-references by using the “«#...»” format and citations by using “«@...»”. 
What you put into your file depends on whether you are using WordRef to generate 
a bibliography before (actually, on whether the bibliography goes in this particular 
file, if you have a multi-file document).  If there is not a bibliography in this file,  
you start it out by saying

«INCLUDE MyFile.refs»

where you substitute the correct name for MyFile.  Do not hit a return after the 
“»” unless you want it to appear in the file.  If there is a bibliography in the file, it  
should look like this:

«DATA MyFile.bibdata»«INCLUDE MyFile.refs»
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(The main part of the paper goes here)

Bibliography

«INCLUDE MyFile.bibincl»

Again, you should fill in the correct name for MyFile.  

Save the file from within Word.  This may seem kind of obvious, but there’s a 
subtle point here about saving the file.  WordRef reads the Microsoft Word file 
directly.  It does this even though I don’t know the format of Microsoft Word files.  
What I do know is that the text is stored as plain text in the file most of the time.  
The only time it is not saved that way is when Fast Save is turned on (the default is 
to do a Fast Save whenever you choose the Save menu item).  Even when Fast 
Save is turned on, a “slow” save happens fairly frequently if the document has 
changed a lot.  What I am trying to get at is that WordRef may have problems if  
you make a few small editing changes to the Print Merge variables which it  is  
supposed to understand and then save the file out using the Fast Save option.  To 
get around this problem, you need to choose “Save As…” from the File menu and 
then un-check “Fast Save” in the dialog box and click OK.  (You will have to 
confirm that you want to overwrite the file.)  For safety’s sake, you should always 
do this prior to running the files through the WordRef application.

If  you are  using WordRef to  generate  a  bibliography,  you need to  set  up a 
bibliographic style sheet as described in section 5.3.  

Run the WordRef application.  The first time you do this, you will need to set 
up  a  new  manuscript  file.   I  tend  to  name  my  manuscripts  with  the  name 
“MyFile.manu”.  If you do the same thing, then WordRef will suggest a lot of 
reasonable names for you as you set up the miscellaneous files.  You need to add 
all the Word and bibliographic files to the manuscript as described in section 2.1.1 
and set up the miscellaneous files as per section 2.1.2.  If you are generating a 
bibliography, you want to set the Citation and Bibliography options, as well.

Finally, go back to Word and do a “Print Merge…”  into a “New Document”.  If 
all  goes  well,  you  will  have  a  fully  formatted  document  with  all  the  cross-
references and citations and bibliography entries filled in.

6. Advanced Issues

6.1. All about cross-references

The description of cross-references in section 2.2 was somewhat simplified in 
that  it  did  not  describe  the  full  gamut  of  operators  or  worry about  things  like 
operator precedence.  The complete format for an expression is:

variable
number

expr + expr
expr - expr
expr * expr
expr / expr
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- expr
( expr )

variable ++
++ variable
variable —-
—- variable
"string"

expr & expr

The operators +, -, *, and /, represent addition, subtraction, multiplication, 
and division, respectively.  - is also used for negation.  In all these cases and in 
enclosing  an  expression  within  parentheses,  the  expressions  are  converted  to 
numbers  before  the  operation  takes  place.   The  expression  must  begin  with  a 
number for this to be considered a valid operation, and anything that occurs after 
the number will be lost.  For example, the expression

"1abc" + "4def"

will result in the value 5, whereas the expression

"1abd" + "def4"

will result in an error.  (The expression "1abd" + def4 would be OK, because 
def4 would be considered a variable.)  

++ and -- are the increment and decrement operators, respectively.  They cause 
the variable to be increased/decreased by one.  The value of the expression depends 
on whether the operator precedes or follows the variable:  if the operator precedes 
the  variable,  the  incremented/decremented  value  of  the  variable  is  used  in  the 
expression; if it follows the variable then the original value of the variable is used. 
For example, if fig had the value 4, then the expression

2 * (++fig)

would have the value 10, whereas the expression

2 * (fig++)

would have the value 8.  In either case, the new value of  fig would be 5.  The 
increment/decrement  operators  also  work  a  little  differently  from  the  other 
arithmetic  operators  in the way that  they handle non-numeric characters  in the 
variable.   The  other  operators  require  that  the  variable  begin  with  a  digit;  the 
increment/decrement operators parse the variable into separate number fields and 
increment/decrement the last one.  So for example, if the variable fig contains the 
value “Figure 3.9.”, then doing ++fig would result in its having the value 
“Figure 3.10.”.

The final operator, &, is the string concatenation operator.  If the expression is a 
number, it will be converted to a string and concatenated.

The  order  of  precedence,  from  the  lowest  to  the  highest,  is  given  in  the 
following table:
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&

+, -
*, /

++, --
- (unary)

All of the binary operators (&, +, -, *, /) are left-associative.

In addition to the operators above which can appear in expressions, there are 
several assignment operators.  The possible assignments are

«#variable : expr»
«#variable +: expr»
«#variable -: expr»
«#variable *: expr»
«#variable /: expr»

The first of these is the normal assignment operator.  The other four cause the 
expression to be added to, subtracted from, multiplied by, or divided into the given 
variable, respectively.  Thus, for example, if figure is 2, then the expression 

«#figure *: 3»

would have the value 6.  Note the difference here:  if figure is "1.3", then the 
expression

«#figure : ++figure»

would have the value "1.4" whereas the expression

«#figure +: 1»

would have the value 2 (since an arithmetic operation is performed, which converts 
the "1.3" into the number 1).

6.2. The BibTEX file format

The BibTEX file format allows considerable leeway in its  syntax.   The file 
format which is understood by the WordRef application is a subset of the full file 
format which, by a happy coincidence, is the same subset which the WordRef stack 
produces.  The syntax looks like this:

@reference-type{key,
field1 = "string1",
field2 = "string2",
• • •
fieldn = "stringn"

}

where reference-type is one of the thirteen reference types listed in section 
3.1.  key is the key which will be used in the citation to identify the bibliographic 
reference.  The  field1 … fieldn are the names of the required or optional 
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fields for the particular reference type, and the  string1 … stringn are the 
values of the fields.  Note that there is no comma after stringn.

If  you  have  a  pre-existing  BibTEX file,  you  will  want  to  read  it  into  the 
WordRef  stack  and  use  the  output  of  the  WordRef  stack  as  the  input  to  the 
WordRef  application.   This  is  because  the  WordRef  stack  understands  a  wider 
variety of syntax in the file.  In particular

• The reference may be enclosed within parentheses rather than braces (e.g., 
@book(...)).

• Instead of strings enclosed within quotes, a series of tokens within braces is 
permitted.  

• White  space  within  quotes  or  braces  is  ignored except  in  as  much as  it 
separates the tokens.  Thus, you can have returns which will get converted to a 
space in the final string.  In normal BibTEX, the capitalization of the tokens within 
the braces is modified to suit the particular bibliographic style and braces within 
braces are used to prevent changes in capitalization.  For example, there may be a 
field like

title = {Test Of {English} As A Foreign Language},

where the title may appear “Test of English as a foreign language” or “Test of 
English as a Foreign Language” depending upon the style.  The braces around the 
“English” keeps the capitalization from being altered.   WordRef  does not  alter  
capitalization.  Thus, when the WordRef stack reads in the reference, although it 
retains the braces, it does not write them out when you write the bibliography for 
use with WordRef.  In this case, the title written out will be “Test Of English As A 
Foreign Language”.

• BibTEX allows diacriticals to be expressed.  The syntax for the diacriticals 
is \tag{letter}, where tag is “"” for an umlaut, “'” for an acute accent, “`” 
for a grave accent, “^” for a circumflex, “~” for a tilde, and “c” for a cedilla. 
Thus, for example, you could have a field like

author = {Erwin Schr\"{o}dinger and Ren\'{e} 
Descartes},

describing a paper I’d love to get my hands on!  The WordRef stack converts this 
into the Macintosh’s extended ASCII set, so this reference would be entered into 
the card as “Erwin Schrödinger and René Descartes”.  If the particular character 
does not exist in the Macintosh character set (e.g., “\c{t}”, the sequence will be 
unconverted.

• BibTEX has a number of special characters which will be converted; these 
are shown in the following table:

\copyright
©

\pounds
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£

\dag
†

\ddag
‡

\S
§

\P
¶

\oe
œ

\OE
Œ

\ae
æ

\AE
Æ

\aa
å

\AA
Å

\o
ø

\O
Ø

\ss
ß

?‘
¿

!‘
¡

--
–

---
—

The special characters “\l” and “\L” for “\o(l,–)” and “\o(L,–)” are not converted 
(they do not exist in the Macintosh character set).
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6.3. Setting up bibliographic style sheets

As a service to WordRef users, I am willing to include any bibstyle files that are 
mailed  to  me  with  future  releases  of  WordRef.   Of  course,  I  cannot  assume 
responsibility for the correctness of any particular style that is sent to me, but the 
hope is that eventually together we can develop a library of bibliography styles that 
encompasses most of the common journals.

The best way to set up a bibliographic style sheet of your own is to start from 
the CACM.bibstyle file, which formats bibliographic entries in the style used by 
Communications of the Association for Computing Machinery.  The basic idea is to 
tell Print Merge what to do for each different type of reference.  The names of the 
fields which appear for each type of reference are exactly as they appear in the 
table in section 3.1.  If a field is optional, you should always enclose it within the 
Print  Merge  directives  «IF  …» and  «ENDIF».   For  example,  if  month is  an 
optional field you want to include followed by a comma if it appears, you would 
put

«IF month»«month», «ENDIF»

at the point in the reference where you would want it to occur.

There  are  three  Print  Merge  fields  which are  available  which do not  occur 
directly in the reference.  These are key, refType, and numEditors.  The key 
is the tag which is used to identify the article according to the citation style (see 
section 2.1.3 for more details).   refType is one of the reference types which 
appear in the first column in the table in section 3.1.  numEditors is used if 
there is an editor field to specify how many editors are present.  This is useful 
for making plurals, for example 

«IF editor»«editor» (Editor«IF 
numEditors>1»s«ENDIF»),«ENDIF»

which will produce the outputs “Mary Q. Contrary (Editor),” and “Jack Spratt and 
Peter P. Eater (Editors),”, with different values in the editor field.

It is recommended that you define a style name for the paragraph style(s) used 
by the bibliographic entries.  This will allow you to import the style(s) into your 
document in case Word runs out of memory while compiling a bibliography (not a 
totally unlikely occurrence).

6.4. Changing the defaults for new manuscripts

You can change the default Citation and Bibliography options which will occur 
when you create a new manuscript if you have a copy of ResEdit or any other 
resource editor that knows about TMPL resources.  In the WordRef application, 
there is a TMPL resource describing a resource type called “Bibo”.  If you paste 
this resource into (a copy of) your resource editor, then you can open the “Bibo” 
resource contained within (a  copy of)  the WordRef application and change the 
options directly.
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6.5. Using WordRef Unlimited

If you should chance to be using WordRef under Word 3 or 4 and run into 
Word’s  limit  of  127  Print  Merge  variables,  there  is  still  hope.   The  easiest 
expedient  would  be  to  upgrade  to  Word  5,  but  if  such  a  course  of  action  is 
unacceptable  for  any  reason,  there  are  still  two  approaches  for  solving  your 
problems.

The first approach involves breaking your document into several files that do 
not  need  to  refer  to  one  another  with  cross-references.   \Simply  create  a  new 
manuscript for each file and process them separately.  If you are close to the limit 
but still not quite fitting, you can also break out your bibliography by putting the 
«DATA» statement at te top of a different file that does not include the refs file, 
process the bibliography separately, and then include the  merged version of the 
bibliography into your main file using an «INCLUDE» statement.  The drawback 
with this technique is that you need to remember to process the bibliography again 
every time you change a citation, or the bibliography could get out of sync with 
your file.

The second approach involves using WordRef Unlimited.  The reason I put this 
approach second is that it really slows things down; you will probably want to print 
all of your drafts using the symbolic values and only use WordRef Unlimited when 
you  are  ready  to  produce  your  final  document.   One  advantage  that  WordRef 
Unlimited  has  over  any  other  method  is  that  it  is  able  to  do  the  Print  Merge 
substitutions in footnotes, which the normal Word Print Merge ignores.  Here are 
the instructions for using WordRef Unlimited:

  1.  Save a copy of your file in Interchange (RTF) format.  You should retain 
the original copy and make all future changes to it.

  2.  Run WordRef Unlimited.  Choose “Process File” from the “File” menu and 
select the RTF file you just created.  Then give a name for a new RTF file.

  3.  Open the new RTF file in MS Word and choose “Yes” to the question 
“Interpret RTF text?”.  If this file does not have a bibliography in it, (i.e.,there are 
no <<DATA ...>> and <<INCLUDE ...bibincl>> statements), then what you see is 
the final copy of your document.  If there is a bibliography, then do a Print Merge 
as usual.  You will not encounter the “Too many data fields” message this time.

7. Troubleshooting

There are a three places where problems can occur.  You can run into problems 
in the WordRef stack, while running the WordRef application, or while performing 
the Print Merge in Word.

7.1. WordRef stack

Problem

Probable Cause

Solution(s)
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Field  does  not  fit  in  allotted 
space.

Either  you  have  a  very  long 
field (have you been reading 
high-energy  physics?)  or  I 
have  not  allowed  adequate 
space.

If you feel the space allowed is 
generally  inadequate,  report  it 
to me and I’ll try to move the 
card  around  to  allow  more 
space.

If your field is unusually long, 
you  can  try  typing  it  in  the 
comments field, so you can see 
what  you  are  doing,  and  then 
cut  and  paste  it  into  the 
appropriate  field.   The 
information will  all  be present 
in  the  field,  even  though  you 
can’t see it all.

The  text  is  difficult  to  read 
when you type it in the fields.

You  probably  don’t  have 
Helvetica  10 in  your  System 
file

Use  the  Font/DA  Mover 
application to  install  Helvetica 
10 in your System file.

Unknown  field  in  importing 
BibTEX file.

(1)   Misspelled field in your 
BibTEX file or a field that the 
stack does not support for that 
reference type.

Correct the spelling in your file 
(case doesn’t matter).

(2)   You  are  using  home-
brewed fields  or  using fields 
that BibTEX supports but the 
WordRef  application  doesn’t 
(like key or crossref).
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Do  nothing.   The  information 
will be automatically read into 
the  “Other  fields” field  of  the 
card.

7.2. WordRef application

References  found  but  output 
not selected.

There  were  Print  Merge 
variables beginning with “#” 
in  the  file,  but  you  did  not 
select Output References.

Choose “Output References” in 
the Options menu (if you have 
no bibliographic references) or 
“Output  Everything”  (if  you 
do).

Citations found but output not 
selected.

There  were  Print  Merge 
variables beginning with “@” 
in  the  file,  but  you  did  not 
select Output References.

Choose “Output References” in 
the Options menu (if you have 
no cross-references) or “Output 
Everything” (if you do).

You need to specify a XXX.

XXX here is the name of one 
of  the  miscellaneous  files. 
You have not given names to 
some  miscellaneous  files 
which  are  required  for  the 
kind  of  processing  you  have 
selected.

(1)   Select  a  different  kind of 
output  in  the  Options  menu 
which  does  not  require  the 
miscellaneous file XXX, or

(2)   Specify  a  name  for  the 
miscellaneous  file  by  clicking 
in  the  appropriate  grey 
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rectangle.

Non-silent  reference  has  no 
value.

You  have  a  reference  for 
which  there  is  no 
corresponding definition.

Check  the  spellings  of  the 
reference  and  the  definition  it 
was intended to have.

Symbol  has  more  than  one 
value.

You  have  defined  a  Print 
Merge variable  which has  to 
have  different  values  in 
different  places  where  it 
occurs.

Make  the  variable  a  silent 
reference (see section 2.2.4.)

String table overflow.
Field > 256 characters

(1)   You  have  a  very  long 
Print Merge variable (heaven 
knows what you were doing!).

Break  up  your  mammoth 
statement  into  several  shorter 
statements.

(2)   Possibly,  you  forgot  to 
turn off  Fast  Save when you 
saved your Word file.

Save  your  Word  file(s)  again, 
being sure to turn off Fast Save.

(3)  Most likely, you forgot to 
close one of your print merge 
variables with ».

Find the « which has no ».

7.3. Print Merge in Word

Unknown field name.
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This is a tough one in Word 3 
or 4 because Word doesn’t tell 
you  the  name of  the  field  it 
did not find.

(1)  You did not turn off Fast 
Save  when  you  saved  your 
Word file(s).

Save the Word file(s) with Fast 
Save turned off.

(2)   You  haven’t  run  the 
WordRef application since the 
last  time  you  changed  your 
citations or cross-references.

Run  the  WordRef  application 
and  choose  “Compile 
References…”  from  the  File 
menu.

(3)  You left out the “#” or the 
“@” in a Print Merge variable 
you  wanted  WordRef  to 
handle.

Correct  them  and  re-run  the 
WordRef application.

(4)  You used an invalid field 
name  in  your  bibliography 
style sheet.

You  can  tell  if  this  happened, 
because  if  you  leave  out  the 
«DATA  ...» and  the 
«INCLUDE ...bibstyle» 
lines, the problem goes away.

You need to take a close look at 
all  the  reference  types  in  the 
style  sheet  to  make  sure  you 
haven’t  misspelled  any  of  the 
field names.

Not  enough  memory  to 
complete operation.

Word was not  able to assign 
paragraph styles.
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If you have defined a paragraph 
style in your bibliography style, 
you  can  read  it  into  the  new 
document and set the paragraph 
styles manually.

Too  many  Print  Merge 
variables.

Word 3 and 4 have a limit of 
127 Print Merge variables.

(1)  Upgrade  to  Word  5.   The 
limit  in  Word  5  is  more  like 
4000.

(2)  Break  your  document  into 
chapters  that  do  not  refer  to 
each  other.   Break  out 
bibliographies  (the  «DATA» 
statement  uses  27  variables) 
that  you merge  separately  and 
«INCLUDE» at the right place.

(3)  Use  WordRef  Unlimited 
(see section 6.5).

Substitution  not  made  in 
footnote.

That’s  right.   Word does  not 
do  Print  Merge  substitutions 
in footnotes.  (It also ignores 
headers  and  footers,  but  that 
doesn’t come up as often.)

Use  WordRef  Unlimited  (see 
section 6.5).

8. Release Notes

8.1. Updating to the new version

The 1.4.1 version differs from the 1.4 version only in having an updated version 
of the application.  You should discard the 1.4 version of the application and use 
only WordRef 1.4.1.

Updating to the 1.4 version of WordRef is not difficult.  The manuscript files 
from previous versions are completely compatible with the new version of  the 
WordRef application.

To update to the 1.4 version of the WordRef stack, you should choose “Write 
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BibTeX” on the head card of the old stack with the option “Other BibTeX”.  Then 
you can open up the 1.4 version of the stack and choose “Read BibTeX”.  You 
should under no circumstances cut a card from an old version of the stack and 
paste into a new version.  Since there is no change in functionality between the 1.3 
and 1.4 versions of the stack, you can just continue to use the 1.3 version.

8.2. WordRef stack

Changes in the 1.4 version:

• Converted to HyperCard 2.0 format

• Cosmetic changes

Changes in the 1.3 version:

• Visual feedback is given when the Comments or Other Fields fields are not 
empty.

• It  is  now possible  to  change  a  card  from one  reference  type  to  another 
automatically.

• The pop-up menus have an item at the top explaining what operation is to be 
performed.

• Support for defining and referring to strings has been added.  This includes: 
(1) a button to bring up the Strings field, (2) a button to read new strings from a 
file, (3) a button to write just the strings to a file, and (4) recognition that any field  
on a bibliography card that begins with a period (or full-stop, “.”) refers to a string.

• The command to find duplicate keys now finds all duplicate keys in a single 
pass through the stack.

Changes in the 1.2 version:

• A couple of bugs which could cause crashes were fixed.

Changes in the 1.1 version:

• Double quotes are handled gracefully in BibTeX files and the stack.

• Carriage returns in fields no longer cause problems.

• Unknown fields are read into an “Other fields” field.

• Handles diacriticals (accents) more thoroughly in BibTeX files.

• The correct name is now displayed when reading BibTeX files if  not all 
required fields have been filled in.

• Empty fields are now handled correctly when reading BibTeX files.
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8.3. WordRef application

Changes for the 1.4.1 version:

• Fixed a bug that caused crashes in some configurations and annoying menu 
flickering in those configurations that did not crash.

• Added a ‘vers’ resource. 

Changes for the 1.4 version:

• Fixed a bug that caused the last reference in a stack not to be found if both 
the last two references were cited.

• Outputs references, even if some citations are not found.

• Puts  the  <<SET>> declarations  on separate  lines.   This  fixes  a  bug that 
caused an extra blank line to appear where the refs file is <<INCLUDE>>d.

• Outputs the offending key when a parsing error occurs in the bib file.

• Changed file  menu item “Open...”  instead of “Open”,  which allows it  to 
open a manuscript from Multifinder when WR is already running.

• Added Command-W as a keyboard equivalent for the “Close” menu item.

Changes for the 1.3 version:

• Fixed some bugs.

• Searching of bibliographies is substantially faster when the bibliography is 
output by the 1.3 version of the stack (or later).

Changes for the 1.2 version:

• Added the “Verbose” option to make debugging easier.

• Added citation templates to enhance customizability of citations.

• Put an example in the “Citation options…” dialog box.

• Handled the “missing author” syndrome better (see section 2.1.3).

• Fixed some bugs which could cause crashes or hangs.

Changes for the 1.1 version:

• Checks for out-of-memory conditions.

• Citations  are  now  properly  disambiguated  when  there  are  identical 
authors/years so that they correspond with the bibliography entried.

• With numeric tags, there are now options to sort either in citation order or 
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alphabetical order.

• Multiple selections have been disabled in the scrolling file lists (since they 
didn’t work).

• A bug which caused the application to hang occasionally was fixed.

8.4. WordRef Browser desk accessory

Changes for the 1.4 version:

• None

Changes for the 1.3 version:

• Initial release.

8.5. WordRef Unlimited

Changes for the 1.4 version:

• Initial release.

8.6. CACM.bibstyle

Changes for the 1.4 version:

• “Proceedings” does not put “(Ed(s).)” after editor(s).

• “TechReport” puts a comma between the author and title, puts the title in 
quotes, omits the string “Tech. Report”, and puts a comma between the month and 
the year.

• “Unpublished” puts a comma between the author and title, and puts the title 
in quotes.

Changes for the 1.2 and 1.3 versions:

• None.

Changes for the 1.1 version:

• There was a misspelling in the CACM.bibstyle file distributed with the 1.0 
version which prevented technical reports form working properly.  The style sheet 
should test for equality with “techreport”, not “techReport” (Word is case-sensitive 
in this comparison).

8.7. IEEE.bibstyle

Changes for the 1.4 version:
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• Initial release

9. Wish List

Understand Word “Fast Save” format.

Tie citation/author styles to bibliography style sheets.

Handle capitalization of titles.

Style changes (sub and superscript at a minimum) within fields.

More generality in citation styles allowed.

Be able to search for references in the WordRef Browser.
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